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Opening a Camera 
Once the application is launched, go to File and Open Device: 
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Select the camera and press "OK" 
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After a moment, the main screen with show the video display screen. 

 

Troubleshooting 
If the camera does not show up on the list, click “Cancel.” Next, ensure the camera is powered 
on and connected to the PC. Follow the steps again to see if the camera appears. 

USB3 
If the camera does not show up on the list, click “Cancel.” Next, ensure the camera is powered 
on and the USB3 cable is connected between the camera and the PC. The camera must be 
connected to a USB3 port on the PC (the port may be blue in color or be marked as USB3, ”SS” 
or SuperSpeed). 
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Verifying the Driver 
If other viewing software is installed on the PC, it may be possible that the camera is not using 
the correct driver. 
 
Open Device Manager, look for “Universal Serial Bus devices.” There should a device listed for 
the camera within that category called “USB3 Vision Device.” If the device is not listed, the 
driver may not be installed or selected. 

 

Configuring the Camera 

Modifying Parameters 
Parameters can be modified in two ways. Basic settings can be modified on the “Video Settings” 
tab. 
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Directly Modifying Parameters 
A complete feature parameter list is available on the “Camera Settings” tab. Clicking on the 
Attribute name will update the “Parameter” box below. This box, if possible, will contain a 
description of what the parameter does. 
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Viewing XML 
The complete XML file sent from the camera can be viewed. Go to “GenICam” and select “View 
XML.” 
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The XML will be displayed in a separate window. 

 

Save/Restore 
It is possible to save and restore the settings of a camera (the GenICam settings and for certain 
cameras, the sensor register settings). 

CMV50000 
Open the CMV50000 menu. Select “Save State” 
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Select a location and name for the configuration to be saved to. 
 
To load, select “Load State” and select the .ini file saved previously. 
 
Note that not all .ini files are valid saved configurations. 
 
Note that the save and load operations take a long time to complete. 

Scripting Configurations 
The application supports scripting configurations with a set of commands; this includes 
GenICam register read/write/execute, sensor register peek/poke, sleep and the ability to 
compare read values to expected values. Parameters in angle brackets ​<parameter> ​ are 
required, parameters in square brackets ​[parameter] ​ are optional. 
 
Command Syntax Description 
HELP HELP [cmd] Displays the possible commands that can 

be used [or just the details for the given 
command] 

CMP CMP <value> [mask] Masks the previous result and compares 
versus Value 

GENI READ GENI READ <address> Reads a GenICam address 
GENI WRITE GENI WRITE <address> 

<value> 

Writes to a GenICam address 

GENI EXEC GENI EXEC <command> Executes the named command 
GENI SAVE GENI SAVE <filename> Save the GenICam configuration of the 

camera to the named file 
GENI LOAD GENI LOAD <filename> Load the GenICam configuration of the 

camera from the named file 
SLEEP SLEEP <sleep_time> Sleeps for sleep_time milliseconds 
PEEK PEEK <address> PEEKs at sensor address 
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POKE POKE <address> <value> POKEs value to the sensor address 
CAM START CAM START Start camera streaming images using 

current GenICam parameters. 
CAM STOP CAM STOP Stop camera streaming. 
CAM WAIT CAM WAIT [msec] Wait for a frame from the camera. If msec 

is not specified, wait forever. 
REC START REC START Start recording frames 
REC STOP REC STOP Strop recording frames 
REC SAVE REC SAVE [filename] Save the current frame to file <filename> 

if no filename is given, the default 
filename of 
<DIR>/<PREFIX><frame#>.<FMT> will 
be used. If the filename is relative, it will 
be stored under the recorder DIR 

REC PREFIX REC PREFIX [prefix] Set the recording filename prefix. If 
[prefix]  is not given, display the current 
value. 

REC DIR REC DIR [directory] Set the recording directory. If [directory] 
is not given, display the current value. 

REC FMT REC FMT [format] Set the recording file format If [format]  is 
not given, display the current value. Valid 
formats are shown in HELP 

PROMPT PROMPT <type> <message 

text> 

 

type is the QMessageBox 
StandardButton mask for the buttons to 
include 
 NoButton ​     ​= ​ ​0x00000000 
 ​Ok ​           ​= ​ ​0x00000400 
 ​Save ​         ​= ​ ​0x00000800 
 ​SaveAll ​      ​= ​ ​0x00001000 
 ​Open ​         ​= ​ ​0x00002000 
 ​Yes ​          ​= ​ ​0x00004000 
 ​YesToAll ​     ​= ​ ​0x00008000 
 ​No ​           ​= ​ ​0x00010000 
 ​NoToAll ​      ​= ​ ​0x00020000 
 ​Abort ​        ​= ​ ​0x00040000 
 ​Retry ​        ​= ​ ​0x00080000 
 ​Ignore ​       ​= ​ ​0x00100000 
 ​Close ​        ​= ​ ​0x00200000 
 ​Cancel ​       ​= ​ ​0x00400000 
 ​Discard ​      ​= ​ ​0x00800000 
 ​Help ​         ​= ​ ​0x01000000 
 ​Apply ​        ​= ​ ​0x02000000 
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 ​Reset ​        ​= ​ ​0x04000000 
 ​RestoreDefaults ​    ​= 
0x08000000 

Command Console 
Open the command console by going to “Controls” and selecting “Command Console.” The 
commands are typed into the box then press “enter” or click “Do it:” 
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Output will be displayed in the large text box:

 

Scripts 
Scripts are text files that consist of the commands used in the command console. The file is 
executed and a results window presented at the end showing the output of the commands. 
 
To execute a script, go to “GenICam” then select “Run Script…” 
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Here is an example script in a .txt file which uses the Sensor Peek/Poke to write 3 registers 
directly to the sensor, wait, then read back the results: 

 
After running the script, a results window is displayed: 

 
 
The results of the sleep/poke commands are OK if the command completed successfully. 
The result of the PEEK command is the value that was read from the sensor. 
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A more advanced script that sets acquire parameters, takes an image, saves it, and repeats 
might look like. 
[NOTE: Values (especially register/genicam) are illustrative only… not based on real camera 
settings! 
 
POKE 0 0 

POKE 22 114 

# Set the exposure time 

GENI WRITE ExposureTime 10000 # 10 ms exposure 

# Set the capture mode to single frame 

GENI WRITE AcquisitionMode SingleFrame 

#Start acquisition 

CAM START 

#wait for a frame from the camera 

CAM WAIT 

REC DIR C:\work\camera 

#Save the frame to a uniquely named file in recorder DIR 

REC SAVE reg_22_114.tif 

# Change a register setting… 

POKE 22 82 

#Start acquisition of the next frame 

CAM START 

#wait for a frame from the camera 

CAM WAIT 

#Save the frame to a uniquely named path 

REC SAVE c:/files/reg_22_82.tif 

# Stop acquisition 

CAM STOP 
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Video/Live View 

Capture Modes 

Continuous Video 
In the Acquisition parameters box, select “Continuous” for Acquisition mode. After setting the 
exposure time and frame rate, press the “play” button above the display box. 

 
The video in the display box will begin updating. The frame counter in the lower right hand 
portion of the display will begin incrementing with the received frames. 
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Burst Capture 
Burst capture is when the camera collects frames at a rate faster than the interface can handle. 
The frames are then sent to the PC at a rate that can be handled. Set the “Acquisition mode” to 
“SingleFrame” or “MultiFrame” then, configure the “Number of Frames” if applicable. 
 
Clicking the play button will initiate the capture. After receiving and displaying the requested 
number of frames, the application will go back into the “Idle” state. 

Single Frame Snapshot 
Clicking the “Camera” button will initiate a single frame capture. It will configure the Acquisition 
mode to “SingleFrame” and grab an image. The image will be displayed and the application will 
return to the Idle state. 
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Video Display Adjustments 

 

Display Brightness 
Add/Subtract value from every pixel being displayed. 

Display Gain 
Multiply every pixel by value.  For color images, red/green/blue channels have a seperate gain 
value. When “Same Gain for all Channels” is set, the red gain value is used for all channels. 

White Balance 
Performs a simple white balance algorithm. Algorithm works off the grey world assumption, by 
changing the gain to normalize the average pixel value so that the average of each channel is 
equal. This will not work in all situations but should get close. 

Display Gamma 
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Video Display Controls 

 

Keep Aspect Ratio 
When this is checked, the viewer will adjust the image display size to maintain the original 
aspect ratio of the frame as acquired. 

1:1 
When “1:1” is enabled, the display is set such that there is a pixel for pixel representation of the 
frame displayed (zoom is disabled). 

None 
The “None” action turns off all the image interaction modes (except PAN) 

Zoom 
When zoom is selected, the user can draw a rectangle around the area of interest on the image 
and it will be magnified to fill the display (honoring aspect ratio, if checked). When Zoom is 
enabled, other image interaction modes are disabled. Only 1 level of zoom is supported, you 
can select “Zoom Out Full” from the context menu to reset/re-start zoom. 

Panning 
If the user holds the shift key and left clicks on the image, panning mode is initiated. As you 
drag the mouse around the image pans accordingly. 

Save Image 
To save the current frame as a file, select Recorder->Save One Frame and you will be 
prompted where to save to. See ​Supported 
File Types 

Copy Image 
Select “Copy Image” from the context 
menu to copy the image to the clipboard. 
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[note that the Ctrl-C shortcut is currently broken] 

Load Image from file 
For debug/review purposes, you can load a saved image from disk and display it in the viewer. 
As this is not a video frame, you cannot use image processing functions on loaded images 
(plotting, etc). 

HDMI Control 
If the Critical Link camera supports HDMIControls, the image viewer can act as a preview to 
select the HDMI ROI. 

Starting HDMI Video 
In the “Video Settings” tab, set the frame rate to be 30Hz (to allow for smooth video play on the 
HDMI display) and continuous acquisition. Click the play button. The image preview will begin 
updating. 
 
In the “Camera Settings” tab, expand the HDMIControl group. Click “HdmiStart” to begin 
outputting frames over HDMI. 

Page 20 



GenTL Viewer User Manual December 6th 2019 

Setting HDMI ROI 
Click the “HDMI” view option on the image display. 
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WIthin the image, click and drag to select a rectangle that will be displayed on HDMI. The 
selected HDMI ROI will be displayed as a red bounding rectangle. 

 

Recording 
Recording saves every frame that is received while recording is enabled. 

Acquisition Modes 
Recording is generally done in either “Burst Capture” or “Continuous” mode but can be done 
using separate snapshots. 
 
In continuous mode, the camera may be forced to drop frames. Because of this, the recording 
may not contain complete data. It is important to select a frame rate that is appropriate when 
recording in continuous mode. 
 
“Burst Capture” mode will capture, at the configured rate, the number of frames requested. This 
guarantees the recording will have all of the data requested. 
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Recording Control 
Open the control by selecting “Controls” and clicking on “Recorder Control.”

 
The control will be displayed. 

 
1. Clicking this opens selection of the save location 
2. Selects the format of the images to save. See ​Supported File Types 
3. Sets the prefix for the files to named 
4. Opens the save location in explorer 
5. Triggers the application to stop saving frames; this resets the frame counter 
6. Triggers the application to begin saving frames; frames will be captured and saved until 

“Stop” is clicked 
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Supported File Types 
● TIFF 

TIFF files are created using ​opencv’s imwrite​ and debayered image with all software 
filters applied. 
Note​: 12bit images will be shifted to 16bit as TIFF doesn’t support a 12bit image format 

● PNG 
PNG files are created using ​opencv’s imwrite​ and the debayered image with all software 
filters applied 
Note​: 12bit images will be shifted to 16bit as PNG doesn’t support a 12bit image format 

● DNG 
DNG files save the raw pixel data from the camera with the information needed for the 
dng viewer to debayer/display the image. 
https://en.wikipedia.org/wiki/Digital_Negative 
The files are created by manually creating the TIFF file and adding the appropriate DNG 
v​1.1.0.0 ​TIFF tags.  This standard is not well documented and all viewers may not work 
correctly.  
Note​: Please report any issues with decoding this file format. 
Tested viewers​: 
 

Windows 10 Photos Works 

darktable Works 

UFRaw Partially works. Mono images reported as 
broken. 

Photoshop Unknown. Need a copy of photoshop to 
test 

 
● RAW 

RAW files are created by copying the debayered image with all software filters applied 
directly to a file.  Pixels will be in RGB order.  8bit images will result in a 888 RGB format 
and 12/16 bit images will result in a 161616 RGB format. 
Note​: To parse a raw file, you will need to know the image resolution and whether it is 
8bit or 16 bit.  Although the bitsize could be guessed based on file size if resolution is 
known. 
Note​: 12bit images are not shifted even though they are stored in 16bit format. 
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Plotting 
The plot viewer window allows you to plot data from any of the plugins that provide it. It can be 
used to view rows or columns of image data, various image statistics, and sensor data 
(temperatures, etc). Open a plot widget by selecting “Plot widget” from the view menu, or 
clicking the plot icon on the toolbar. 

 
The plot widget consists of 2 main areas, the plot area and the controls area. 

 

Page 25 



GenTL Viewer User Manual December 6th 2019 

There is a small blue arrow between the 2 areas , which can be used to hide and show the 
controls (allow more plot area).  
Before you can add a curve to the plot, you must first select the data source to plot 

 Once you have done that, you can add curves using 

the “Add Plot…” item in the Plot Legend area . This will bring up 
the plot properties dialog to allow you to select the particular set of data to plot and some 
display options. 

 
The source selected on the plot widget will 
dictate the available data sources show in 
[1]. For the Image Data source, you can 
select Row Data or Column Data. The 
Index/offset control [2] selects the row or 
column (respectively) to plot. 
The title edit box [3] allows you to give the 
curve a specific title. If you do not enter a 
title, the suggested title shown (in grey text) 
will be used. 
Section [4] controls the attributes of the 
lines drawn (or not) for this curve. 
Remember that curve fitting the data will 
require additional processing by the PC and 
may affect displayed frame rate. 
Section [5] provides similar settings for the 
symbols for the curve (which default to 
“none”). 
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Display Tab 
The ​Display​ tab has several controls 
affecting the data presentation. You can 
change the background color and the 
color of the plot, show/hide the grid and 
control the axis scales. Using the ​X​ and 
Y​ axis controls, you can specify the 
range of axis. If you select the 
AutoScale​, the plot viewer will scale 
the axis to the extent of the image every 
time a new image is loaded. The ​Log 
Scale​ checkbox changes the given axis 
scale to a log10 based one. 
The last control in the ​Display​ group is 
the ​Pause Updating​ button. This is a 
toggle button, and when active, the 
snapshot display will not update when 
new images are acquired. 

 

 

Tools Tab 
The ​Tools​ tab has the ​Data Report​ button that will create a csv version of the image data and 
display it in a text viewer. You can then save the text as a file to import into another application. 
You can control how the mouse interacts with the plot using the Mouse Mode group. 
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Disables mouse interaction. 

 
Uses the mouse to zoom. Left 
button to drag and define zoom 
region, right button to zoom back 
one. 

 
Show crosshairs on display when 
left mouse button is down. 

 
Find the nearest point on any 
curve and show it in the bottom 
right corner when left button is 
down. 

Application Updates 
The GenTL Viewer application includes a feature enabling it to check for new versions of the 
software. This check can be initiated manually, or configured to automatically check. 

Settings 
The Application settings dialog provides a group of controls (Updater Options) affecting the 
update checking. 
 

Option Description 

Show all notifications If checked, application will notify every time an update check 
is run. 
If not checked, the application will only notify when an update 
is available. 

Notify me when an 
update is available 

Checking this will have the application check for updates 
when the application starts. 

Enable periodic checks 
while running 

If checked, application will check once per day for updates 
while running. 

Enable integrated If checked, the application will prompt you to download and 
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downloader optionally install the update. If not checked, you will have to 
download the update manually (from a web browser, etc). 

 

 
Application settings - Updater Options 

 
To manually check for updates, select “Check for updates…” from the Help menu. 
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Help Menu - Check for updates... 

 

Plugin Management 
The GenTL Viewer application makes extensive use of plugin modules to provide the correct 
functionality for the camera connected. Each plugin module can provide custom functionality 
based on either a specific family/model of camera or by examining the device’s GenICam XML 
structure for the presence of supported features. When a new camera model (as defined by the 
XML SNFC::DeviceModelName node) is discovered, a new mapping is created for it and any 
plugins that are either enabled by default (as identified by the plugin) or have declared 
themselves compatible based on the camera’s GenICam XML model will be enabled for the 
model. 
 
NOTE: There should be no need to alter the plugin mapping during normal use of the 
application. The following information should be considered for advanced/test usage 
only! 
 
The user can modify this mapping (although one really should NOT do so, unless you really 
know what you are doing!) in the plugin settings dialog, as shown below. Changes made to 
plugin settings will be applied the next time the application is run. 
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Plugin Settings - Select plugins by model. 

You can also change the location  of the plugins directory from the default (again intended for 
development/test). If the application cannot find plugins in the specified path, there will be very 
little you can do with it! 
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Plugin Settings - Select plugins directory. 

 

Plugin Information 
One can see which plugins are currenly available and/or loaded by selecting “Plugins...” from 
the Help menu. This will bring up a dialog box listing all of the plugins found and their current 
status. 
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Help Menu - Plugins.... 

 

 
Plugins Information Dialog 
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Appendix: Canon Sensor IR Plugin 

Description 
 
The CanonIR plugin allows the GenTL viewer to decode Canon RGBIR sensor data. 
 
These sensors replace one of the green pixels in the bayer pattern with a Near Infra-Red (NIR) 
filter .  1

 

  

1 ​https://canon-cmos-sensors.com/canon-3u5mgxs-5mp-cmos-sensor/ 
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Enabling the plugin 
● Open the settings window. File -> Settings… 
● Select the plugins page: 

○ Ensure “Plugin Dir:” is set to the plugins directory in the install path. 
○ Expand the entry for the camera you want to use the plugin with and Check 

“CanonIR”  2

Note: If the camera does not show up, you need to open and close the camera at 
least once. 

○ Click OK to close the settings and then restart the GenTL Viewer. 

 

2 Note: The CanonIR plugin currently only supports the MityCAM-120MXS and MityCAM-3U5MGXS 
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Using the plugin 
● Select a Pixel Format ending in IR. 

 
● Select the “Show IR” button next to the Play button. 
● Select Play. 

 

Page 36 



GenTL Viewer User Manual December 6th 2019 

● When a frame comes in with an IR pixel format, the “IR Video” window will open and 
show you the live IR data. 
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● The RGB color image will be shown in the regular video window 

 
Note: The RGB pixels are still sensitive to IR.  So the image will look washed out without 
an IR filter. The ​IR Subtraction​ feature can be used to reduce this washed out effect. 

 

Recording images 
● Ensure the Recorder plugin is enabled. 
● Open the Recorder Control. Controls -> Recorder Control. 
● Setup where you want the images to be saved and what file format. 
● Hit the record button. 
● Start streaming frames. 
● Each frame will save a Channel 0 and Channel 1 image. Channel 0 is the color image 

and Channel 1 is the greyscale IR image. 
 
Note: The IR image is ½ the resolution of the color image. 
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IR Subtraction 
This feature subtracts the IR data from the RGB pixels. 
 
Each IR pixel value is multiplied by the three IR subtraction ratio values. The results are then 
subtracted from the corresponding color pixel in the 2x2 bayer pattern. 

Configuring IR Subtraction 
● Open the settings window. File -> Settings… 
● Select the CanonIR page: 

○ Select “Enable IR Subtraction” 
○ Default values are selected based on the MityCAM-120MXS @ 820nm.  These 

values will need to be adjusted based on environment and lighting conditions. 
○ Click “OK” or “Apply” for settings to take effect. 
○ Clicking the “Default” button will set all the settings back to default immediately. 

Pressing “OK” or “Apply” is not needed. 
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